PowerPoint 2007

Stephanie Agnew  
sagnew@library.msstate.edu

Thomas La Foe  
tlafoe@library.msstate.edu

(662) 325-8867

More handouts and tutorials: http://guides.library.msstate.edu/imc
<table>
<thead>
<tr>
<th>Topic</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>WORK AREA AND RIBBONS</td>
<td>4-6</td>
</tr>
<tr>
<td>VIEWS</td>
<td>7</td>
</tr>
<tr>
<td>GETTING STARTED</td>
<td>8-9</td>
</tr>
<tr>
<td>WORKING WITH VIEWS</td>
<td>10-13</td>
</tr>
<tr>
<td>WORKING WITH SLIDES</td>
<td>14</td>
</tr>
<tr>
<td>WORKING WITH OBJECTS</td>
<td>15</td>
</tr>
<tr>
<td>WORKING WITH TEXT</td>
<td>16</td>
</tr>
<tr>
<td>WORKING WITH SHAPES AND ART</td>
<td>17-18</td>
</tr>
<tr>
<td>WORKING WITH TABLES, CHARTS &amp; GRAPHS</td>
<td>19-20</td>
</tr>
<tr>
<td>WORKING WITH TEMPLATES AND MASTERS</td>
<td>21</td>
</tr>
<tr>
<td>ANIMATING THE PRESENTATION</td>
<td>22</td>
</tr>
<tr>
<td>PRINTING YOUR PRESENTATION</td>
<td>23</td>
</tr>
<tr>
<td>EXPORTING TO WORD</td>
<td>24</td>
</tr>
<tr>
<td>ADDING HYPERLINKS AND USING E-MAIL</td>
<td>25</td>
</tr>
</tbody>
</table>

Revised 7/07
PowerPoint is an application that lets you build, print, and deliver presentations. You have several options for the delivery of a presentation, but you only have to develop it once. You can print slides (each screen of information), handouts, notes pages, make 35mm slides, make a web page or deliver an on-screen presentation. Only the on-screen presentation allows you to use all of the features in PowerPoint.

As you develop a presentation, it is important to remember that you should not try to include every piece of information you wish to say. PowerPoint slides should contain brief, concise, descriptive phrases that will help remind you what needs to be said during your presentation. The most common mistake made by people is to stuff too much information on each slide.
The Office Button contains options that affect the authoring of documents: creating, opening, saving, printing, publishing, and closing. Many of the options found in the Office Button are similar to those found in the File Menu in previous versions of Microsoft Office.

The Recent Documents list is also longer and allows for documents to be “pinned” to the list by clicking the push-pins next to each document. This means that that document will not cycle off of this list as new documents are opened.

List items that have more than one command each, such as Print, have an arrow beside them. When the mouse stops over Print, other options, like Print Preview, will display on the right of the Office Button Menu.
The Ribbon
The most noticeable change is at the top of the PowerPoint window. Instead of the menus and toolbars, there’s a tall box, it is called the Ribbon, and it’s now your control center for creating a presentation. The set below is made up of the most-used commands called the Home tab. Displayed as buttons, these commands support frequently used tasks, like copying and pasting, adding slides, changing slide layout, formatting and positioning text, and finding and replacing text. There are other tabs on the Ribbon. Each tab is devoted to a type of work you do when you create a presentation. Buttons on each tab are arranged in logical groups. The most popular buttons in each group are the largest.

The Tabs:

**Insert tab.** Here are all the things you might want to put on a slide — from tables, pictures, diagrams, charts, and text boxes to sounds, hyperlinks, headers, and footers.

**Design tab.** Choose a complete look for the slides that encompasses background design, fonts, and color scheme. Then customize that look.
Animations tab. All the animating effects are here. Basic animations for lists or charts are the easiest to add.

Slide Show tab. Select a pen color or a certain slide to start on. Record narration, run through the show, and do other preparatory things.

Review tab. Find the spelling checker and Research service here. Have your team use annotations to review the presentation, then review those comments.

View tab. Make a quick switch to Notes Page view, turn on gridlines, or arrange all your open presentations in the window.

Tabs as you need them. You’ll notice uniquely colored tabs that appear and disappear on the Ribbon as you work. These are contextual tabs, which contain special formatting tools for items like pictures and graphics.
Views
Power Point gives you different layouts for constructing your presentation in addition to the Slide Show. On the bottom right of the screen you will see the View buttons. Mousing over buttons will display a screen tip that will tell which buttons are which. Simply click on the desired view button to move to that view. You can also change views by choosing View from the view ribbon.

Normal View – lets you work with one slide at a time. You can see a combination of Slide View, Outline View and a Notes section on the same screen. You can add clipart, graphs, charts, text and wordart to the slide within this view. This is the default view.

Slide Sorter View – gives you thumbnails of all the slides in full color. Lets you organize the slide presentation by moving, copying, importing or deleting slides. You can also add transition elements to the slides from here.

Slide Show View – allows you run your slides as a full presentation. All the slides are displayed full screen with all added animations, transitions and sound.
Opening PowerPoint:
When you first open PowerPoint 2007, you start off with an initial blank slide called the Title Slide. The Title Slide contains placeholders where you can input the data you wish to include on your first slide.

By clicking on the Office button you can choose to start a brand new presentation via four different methods or you can open an already existing presentation.

Create a new blank presentation.

Open and edit a presentation you have already created.

Create a new presentation or other document from a Template.

**Layouts:**
Layouts are already designed layouts on a slide and can be accessed from the Home ribbon. Layouts make it easy to input data by simply clicking on the proper placeholder in the Layout design and typing in the correct data. When you first open PowerPoint you are automatically given the Title Slide Slide Layout to use, however you can change that slide’s Slide Layout or when you add an additional slide you can pick which Slide Layout you wish to use.

**To change a Slide’s Layout:**
1. Right click on the Slide.
2. Choose Layout from Short Cut menu.
3. Click the desired Layout from pop-up window.
To Add a New Slide:
1. Click on New Slide button in the home ribbon.
2. Choose the Layout.
3. Fill in the slide as desired.

Saving a Presentation:
Once you’ve started a new presentation, you need to save that presentation on a regular basis. When you first save the presentation you need to choose a folder location that will hold the file and a name for the presentation file.

PowerPoint 2007 gives you various file types and options for saving. The most common options are:

- **PowerPoint Presentation**—2007 version
- **PowerPoint Show**
  This file will always open in the slide show view.
- **PowerPoint 97-2003 Presentation**
  You'd save in the old format if someone needed to work in the file that didn't have PowerPoint 2007 or the Compatibility Pack for opening PowerPoint 2007 files.

To save a presentation:
1. Choose the office button, Save As from Menu bar.
2. Select the desired file type.
3. Move to the folder that is going to hold the file from the Save In: text box.
4. Name the file in the File Name: text box.
5. Click Save button.
Moving between Slides:
Once you’ve added a number of slides, you may wish to move back and forth between the slides for additional editing. From within Normal view, you can move from slide to slide in many different ways. You can use the thumbnails on the Slide Outline pane on left side of screen, you can use the scrollbar, you can use the Next/Previous slide buttons and you can use keyboard commands.

To Move from Slide to Slide:
1. Choose Next Slide or Previous Slide buttons on Scroll bar OR
2. Use Page Down or Page Up buttons on keyboard OR
3. Click and hold on scroll box in scroll bar and drag to proper slide OR
4. Use Scroll bar up and down arrows OR
5. Click on thumbnail of slide from the Slide Outline pane on left side of screen.
Depending on what View you are in, will also dictate what other slide movement options are available.

Changing Views:
Within PowerPoint, you can look at your slides in 3 different ways or views.
1. Normal View
2. Slide Sorter View
3. Slide Show View

Normal View – lets you work with one slide at a time. You can see a combination of Slide View, Outline View and a Notes section on the same screen. You can add clipart, graphs, charts, text and wordart to the slide within this view. This is the default view.

Slide Sorter View – gives you thumbnails of all the slides in full color. Lets you organize the slide presentation by moving, copying, importing or deleting slides. You can also add transition elements to the slides from here.

Slide Show View – allows you run your slides as a full presentation. All the slides are displayed full screen with all added animations, transitions and sound.
Outline Pane in Normal View:
The Outline pane allows you to work with the text of your entire presentation in an outline format. You can create, edit and delete slides from this view. You can even create your entire presentation from this view.
You can also view your presentation by individual thumbnail slides by clicking on the Slide Tab in the Outline Pane. Information on the Outline Tab of the Outline Pane is arranged in levels. Each level is indented slightly further than the last from the left margin. The title appears as the first, left most level in the outline.

To add a new slide in Outline View:
1. Click at the end of the slide icon that you wish to add a new slide after.
2. Press Enter key (or click New Slide button on Formatting Toolbar).
3. You can change Slide Layouts for the new slide from the Slide Layout Task pane, if you wish.

Using the Outlining Toolbar:
PowerPoint has numerous toolbars that you can use to work with your presentations. When working in the Outline Pane, you may wish to display the Outlining toolbar. The Outlining toolbar has numerous tools that allow you to manipulate your data in this view.

To display the Outlining toolbar:
1. Choose View, Toolbars from Menu bar.
2. Choose Outlining.
3. The Outlining toolbar will appear on the far left side of the Outline Pane.

Promoting and Demoting:
As mentioned earlier, there are multiple levels in the Outline view. Title text is typically displayed on the first level, while sub-title info in on an indented level. To move to lower levels is called Demoting. Moving to higher levels is called Promoting.

To Promote or Demote:
1. Right click in the text you wish to move.
2. To promote – click the Promote button in the pop-up box. (or press Tab key).
3. To demote – click the Demote button in the pop-up box. (or press Shift + Tab keys).

In the Outline Pane you can also move slides around. Using the Up and Down buttons on Outlining toolbar is probably the most error-free way of moving slides in Outline view. However, you can also move slides by dragging them up and down the Outline pane. Be diligent if you drag your slides because it’s easy to drop the slides in the wrong place.
To move slides using Up & Down buttons on Outline tab:
1. Place cursor in the paragraph you want to move and right-click.
2. Click on the Move Up or Move Down buttons in the Outlining Toolbar.

To move slides by dragging them Up & Down:
1. Point to the bullet next to the text that you want to move.
2. Press and hold mouse button.
3. Drag to new location.
4. Release mouse.

Dragging will move a bullet and any sub-bullets (sub-levels) beneath it. When using the Move Up and Move Down buttons, that will only move the individual paragraphs, unless you first select everything you want to move, then use the buttons.

Slide Sorter View:
The Slide Sorter view will display slides as thumbnails in the order they appear in the presentation. You can easily rearrange, copy, import and delete slides from this view. This view is also great for adding transition effects to each slide or the whole presentation.

To rearrange slides in Slide Sorter view:
1. Click and hold on thumbnail of slide you wish to move.
2. Drag until dark, vertical line appears in the area to which you want to move the slide.

To copy slides:
1. Select the slide you wish to copy.
2. Choose Edit, Copy from Menu bar.
3. Click on the slide you wish the pasted slide to follow.

To delete slides:
1. Select the slide you wish to delete.
(to select multiple slides, hold CTRL key down while clicking on desired slides).
2. Press Delete key on keyboard.
Hiding Slides:
Sometimes you may decide not to show all of the slides in a presentation, but don’t want to delete the slides because you may use them later. You can simply hide the slides from view in the Slide Show presentation.

To hide slides:
Move to Slide Sorter view.
Left-click on the slide.
Click on the hide button from the pop-up bar.

To unhide slides:
Left-click on the slide you want to unhide.
Click on the hide button again.

Slide Show View:
This view is used to see what the presentation would look like if it were truly being projected on the big screen. This view includes all color, graphics, animation and sound that have been added to the presentation. There are many ways to progress through the presentation when in Slide Show view. You can move forward and backward slide by slide, or jump to a specific slide. You can also stop a presentation at any time by pressing the Escape key on keyboard.

To move forward from slide to slide, you can:
Click left mouse.
Press N (for next) on keyboard.
Press Page Down key on keyboard.
Press Enter key.
Press Down Arrow key on keyboard.
Click right mouse button, choose Next.

To move backward from slide to slide, you can:
Press P (for Previous) on keyboard.
Press Page Up key on keyboard.
Press Up Arrow key on keyboard.
Press Backspace key on keyboard.
Click right mouse button, choose Previous.

To jump to a specific slide:
1. Click right mouse button, choose Go.
2. Choose either Slide Navigator or By Title.
Editing Slides:
You can change the look of the text in any slide by formatting. Formatting means, “to change the look of”. By changing the attributes of the slide you can make it look very different from its original state.

**To Change Text Attributes:**
1. Select what you want to affect.
2. Choose the desired formatting feature (i.e. bold, underline, italics, font face, font size, color, etc.) from formatting portion of the Home Ribbon.

Once you’ve put together a set of formats that you like, you may want to apply that same set to another section of text. To copy all the formats you must use the Format Painter from the Clipboard portion of the Home Ribbon.

**Format Painter:**
1. Apply the desired formats to a section of text.
2. Keeping the formatted text selected, double click on the Format Painter button.
3. Select the section of text that you want to apply the formats to.
4. To turn off the Format Painter, press Escape or click on Format Painter button again.

If you only want to copy a single format, or only the last format applied from a series of formats, you can use the Repeat Key (F4). The F4 key will only copy the last format that was applied to another section of text.

**Line Spacing:**
By default, all text is inserted into a placeholder or textbox single spaced. However, you have the option of changing the line spacing of each paragraph of text in PowerPoint.

**To change line spacing:**
1. Select the paragraphs that you want to affect.
2. Click the arrow and the bottom right corner of the paragraph box.
3. In the Change the line spacing to the desired width.
Moving Objects:
Note: very important to remember when moving filled objects – click and hold right in the middle of the object and drag to new location. When moving non-filled objects, you can only move them by clicking and dragging on the edge of the object.

To move an object:
1. Click and hold on object you wish to move.
2. Drag to new location.

Sizing Objects:
All drawn objects can be sized after drawing. You may draw a shape that is too small or too large. Instead of deleting and redrawing, you can simply change the size of the object.

To size an object:
1. Click object to select it.
2. Click and hold on one of the sizing handles.
3. Drag in or out to enlarge or reduce the size of the object.
Note: By holding the Shift key down when resizing, you can keep the same height-to-width ratio.

Deleting Objects:
Every object that you’ve added to a slide in PowerPoint can always be deleted at any time.

To delete an object:
1. Click on the object to select it.
2. Press Delete on keyboard.

Duplicating an Object:
Once you’ve drawn an object you may find that you need another object that is exactly the same shape, size, etc. The chances that you will be able to drawn another object with the exact dimensions and formatting of the first are low. However, you can easily get a duplicate or copy of the original by simply duplicating it. Duplicating and copying are essentially the same steps; however the act of “duplicating” is typically quicker than copying and pasting.

To duplicate an object:
1. Select the object.
2. Choose Copy from the Clipboard portion of the Home Ribbon (or Control + C) and paste (or Control + V).
3. Move the duplicate object to new location, if desired.
Adding Text:
You can add text to any enclosed object by simply selecting the object and starting to type. The text is attached to the object and when the object is moved, the text will move with the object. However, when resizing the object, the text will not automatically resize with the object.

To add text to an object:
1. Click the object to select it.
2. Type the desired text.
3. Click away from object when done.
Text also does not “wrap” when it comes to the edge of an enclosed drawn object. The text will extend outside the borders of the object. To fix this, you can choose options that will wrap the text or adjust the object size around the text.

To wrap text inside of an object:
1. Select the object.
2. Choose Format, AutoShape from Menu bar.
3. Choose Text Box tab.
4. Check Word Wrap Text in AutoShape.
5. Choose OK.
The text will automatically wrap within the object.

To adjust the size of an object around included text:
1. Select the object.
2. Choose Format, AutoShape from Menu bar.
3. Choose Text Box tab.
4. Check Resize AutoShape to Fit Text.
5. Click OK.
This is adjusting the size of the object so that it neatly fits around the text. To make the object larger, you will have to manually size the object by using the sizing handles.
AutoShapes:
Besides being able to draw squares, circles and lines. You also have access to over 150 different specific shapes in PowerPoint.

**To draw an AutoShape:**
1. Click on home ribbon and the shapes are located in the Drawing portion.
2. Choose a shape.
3. Press and hold mouse button on the slide and drag crosshair to create AutoShape.
4. Release mouse button.

**To enhancing a drawn object:**
1. Select the object.
2. Click on desired font color, line color, shadow, 3-D, etc. buttons from Drawing Toolbar.

ClipArt and WordArt:
Clip Art are graphic files that come with the Microsoft Office Suite of programs. Word Art is a program that allows you to create unique looking words.

**To insert Clip Art:**
1. Choose Clip Art button from Insert Ribbon.
2. Select a clip art category.
3. Click on the clip-art image you want to insert.

**To insert WordArt:**
1. Click WordArt button on Insert Ribbon.
2. Select a style.
3. Click OK.
4. Type the text in the box given.
Drawing Tools:
You can draw your own objects in PowerPoint, such as circles, squares, etc. You also have ease of control over changing the shapes of these drawn objects and you can also add text to the drawn objects. You can also duplicate, delete, move, copy, color, cut and paste drawn objects.

The drawing tools are located in the Home Ribbon in the drawing portion. Once you draw you will see another ribbon appear that will allow you to format your shapes and lines.

To use Drawing Tools:
1. Select the drawing tools you would like to use from the ribbon.
2. Place the pointer where you want to start to draw.
3. Click and drag the mouse pointer until the object is the right shape and size.
4. Release mouse button.
5. Shape Styles allow you to change the colors and effects of the shapes.
6. Other options are also available under format shapes dialog box located under the arrow.

Note: if you hold the Shift key down when drawing, this will constrain an object. It makes it easy to draw a perfect circle instead of an oval, for example.
Tables:
You can easily add Tables to your presentation. Tables organize data into vertical columns and horizontal rows. Everywhere a column and row intersect creates a cell. You can any type of data to a cell; text, numbers, graphics, etc.

To add a table to your slide:
1. Add a table by choosing the Table option on the Insert Ribbon.
2. Decide how many rows and column you wish to have.
3. Click OK.

To move from cell to cell in the table:
1. Press Tab key to move from cell to cell or
2. Click in the cell you wish to move to or
3. Use arrow keys to move to cell to cell.

Edit your table by using the Format options in the Table Tools Ribbon.

SmartArt:
PowerPoint comes with an built-in application which helps you build charts, graphs and diagrams easily.

To create graphs:
1. Choose SmartArt for graphs from the Insert Ribbon.
2. Choose which type of graph you wish to create from the pop-up box.
3. Type the necessary information.
4. Click outside of chart area when finished.

Once you’ve added the graph a new ribbon will display, SmartArt Design Tools. From this ribbon you can add components to the graph, change the Layout and apply Style affects.
Charts:
Charts are used to display numerical data graphically. There are 18 different main charts types that you can use in PowerPoint.

To insert a chart:
1. Choose Chart button the Insert ribbon.
2. The chart dialog box will pop-up, choose the chart type.
3. Once you choose the chart type, Excel will open up and you can begin.

Making changes:
Once you have added your chart you will have a new ribbon, Chart Tools Design Ribbon. This ribbon will allow you to make changes, add information, etc.
Design Themes and Slide Masters:
When you start to create a presentation you can choose a Design Theme to use. You can also change the template you’ve chosen later on if you don’t like it.

To change templates:
1. Click on the Design Ribbon.
2. Choose the design that fits your needs.

Every slide will now contain this new template.

Slide Masters:
PowerPoint has three masters: the Slide master, the Handout master, and the Notes master. The masters control the format, design and text that appear on the slides.

The Slide Master controls the format of slides. It contains formatted placeholders for the title and text, as well as background items. If you change the text formatting in Slide Master, then the text formatting for all the slides are affected. You can make changes to your masters by using the slide and the ribbons.

When you apply a template to a presentation, you apply a set of masters that control the presentation’s look and format.
Transitions and Animation:
For each slide in your presentation you can add transitions that happen as you move from one slide to the next. You can also add animation effects to different components of your slide in order to draw attention to certain features of the slides, to emphasize a point or simply for effect. You can add transitions from the Animation Ribbon and choosing the item you want to apply.

To add transitions:
1. Select the slide you want to add the transition to.
2. Click on the Animation Ribbon.
3. Choose the effect you want.
4. Select a speed for the transition.
5. Decide how you wish the slide to transition.

Because of these major enhancements to adding Animation effects, learning to use all of the Animation effects takes time and practice. However, a very basic introduction to adding animation effects will be covered here.

To add basic animation effects:
1. Select the placeholder/object that you wish to animate.
2. Choose Custom Animation from the Animation Ribbon.
3. Click the Add Effect button from the Custom Animation task pane on right side of screen.
4. Choose Entrance from the list.
5. Choose the desired animation effect from sub-list.
6. Choose any additional options for this effect.
7. If you wish to add another animation effect to this placeholder/object, click Add Effect button again.
8. Choose Emphasis from the list.
9. Repeat steps 5 & 6 above.

You can continue to add additional emphasis effects or an exit effect. Once finished creating the animation timeline, you can click the Play button at bottom of task pane to view final animation sequence.
Printing:
You have many options for printing your slides. You can print just slides, or notes pages, handout pages, outlines.

By default, PowerPoint prints in color, however this may not be the best choice if you just want to print Note pages, for example. You may want to tell PowerPoint to just print in black and white to save your print cartridge from wasting unneeded color ink, and it will take less time to print if you print in black and white.

To Print:
1. Choose Print from the Office Button.
2. Select the type of printout you want from the list.
3. Select the number of slides to print in the Print Range box.
4. Select any other desired option.
5. Click OK.
Exporting to Word:
PowerPoint 2007 allows you to also publish your presentation to Word format. Converting your presentation to Word would be useful if you wanted to add additional information to the file that only Word offered or you wanted a specific look to your printed handouts.

To export to Word:
1. Choose Publish from the Office Button.
2. Choose the desired Page Layout format.
3. Click OK.
4. Microsoft Word will open displaying the slides and notes of the PowerPoint presentation.
5. Save and print the new Word document.

Web features of PowerPoint XP:
PowerPoint 2007 also incorporates quite a few internet features such as saving the presentation as a web page, inserting hyperlinks into the presentation and emailing the presentation.

To save a presentation as a Web Page:
1. Choose Save as from the Office Button, then other formats.
2. Select the folder to save the presentation and chose Web page from the Save as Type.
3. Click Publish.
4. Set any further options from the Publish as Web Page window.
5. Click Open Published Web Page in Browser checkbox (at bottom of window), if you liked to see what the published page would look like online.
6. Click Publish button.
Adding Hyperlinks to Presentations:
Hyperlinks (or links) can be easily added to your PowerPoint presentation that not only allow you to link to internet addresses, but can be used to link from one slide to another in the same presentation, to link to other files on your computer or link to an email address.

To add a hyperlink to a presentation:
1. Select the text or object where you’d like the hyperlink to appear.
2. Choose Hyperlink from Insert Ribbon.
3. Decide where you want to link from the Link To: column of the left side of Insert Hyperlink window.
4. Specify the file, webpage, document or email address to which you want the hyperlink to point.
5. Click OK.
6. Test the link by clicking on it for accuracy.

Sending a presentation via email.
You can send a presentation to someone through email. There are many ways that you can send a PowerPoint presentation through email. However, the success of sending a presentation depends a lot on the compatibility of the sender’s and recipient’s email programs.

1. Always send the presentation as an attachment and NOT in the body of the message.
2. Make sure the recipient has PowerPoint also so that they can open and see the presentation with no trouble.

To send a presentation via email:
1. Choose Send from the Office Button and select E-mail.
2. Choose Mail Recipient (as Attachment).
3. Type email address of recipient in Email program.
4. Send email.
Embedding YouTube Video to Your Slides

In **PowerPoint 2007**, go to Office button -> PowerPoint Options -> Popular -> tick "Show Developer tab in the Ribbon".

Click the Developer tab click the last icon "More Controls" which is displayed as hammer plus wrench. In the set of controls available on your computer, select "Shockwave Flash Object". Then use your mouse to draw and resize an area in the slide as you like to place your YouTube video.
Embedding YouTube Video to Your Slides

- Once you have drawn your box on your slide it will look just like the one to the right.

- Go to the YouTube video page you'd like to add, and check the URL in the address bar of your Web browser. You'll get an address like
  
  http://www.youtube.com/watch?v=hChq5drjQl4

- Change the phrase watch?v= to v/, and now the address becomes
  
  http://www.youtube.com/v/hChq5drjQl4

Right click the area you drew which is displayed as a big cross, select Properties and go to Properties tab. Copy and paste the YouTube video address in the field as value of attribute Movie; set the value of attribute Playing and Loop to False. Close the Properties tab when everything is done.

You now may click on “Slide Show” and your Youtube video is embedded in your Presentation.
Notes
Notes
Notes
Contact Us
662-325-7676

Patty Archer Coordinator of IMC
parcher@library.msstate.edu

Stephanie Agnew Instructional Technology Specialist
sagnew@library.msstate.edu

Bobbie Huddleston IMC Specialist
bhuddleston@library.msstate.edu

Dorothy Johnson Library Associate
djohnson@library.msstate.edu

Thomas La Foe Instructional Technology Specialist
tlafoe@library.msstate.edu

Jim Tomlinson IMC Graphic Designer
jtomlinson@library.msstate.edu

The Instructional Media Center offers workshops, one-on-one instruction and an open lab to the faculty, staff and students of Mississippi State University. Choose from one of our regularly scheduled workshops, or allow us to customize a workshop for your class, office or research team. If you need less formal training, ask about a one-on-one session, or simply check out our multimedia lab where our multimedia computers (both Macs and PCs) are equipped with the latest in graphic and web authoring software, scanners, music composition keyboards, video and audio capturing capabilities and more. Our trained staff is available seven days a week to assist you in the design and creation of your projects and presentations.

For more information, visit our website at http://library.msstate.edu/imc

MISSISSIPPI STATE UNIVERSITY
University Libraries

All Workshops Sponsored by Mississippi State University Libraries
Visit http://library.msstate.edu

Discrimination based upon race, color, religion, sex, national origin, age, disability, or veteran’s status is a violation of federal and state law and MSU policy and will not be tolerated. Discrimination based upon sexual orientation or group affiliation is a violation of MSU policy and will not be tolerated.